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How to Use This Guide ....................

This manual does not use complex technical language to explain TML+ 

operations. Regardless of your level of computer skill, you will be able to 

understand this guide.

How the Guide Is Organized

This guide is organized so you can quickly fi nd the answers you 

need.  The manual is divided into seven chapters. Chapter 1 provides 

background information, explains the development of TML+, and 

discusses why TML+ is important. Chapter 2 provides an overview of 

TML+ as well as in-depth instructions for basic program operations. 

Chapter 3 explains how to select a scenario, while Chapter 4 describes 

how to set up your casualty streams. Chapter 5 outlines how to identify 

the levels of care you expect to provide treatment for your patients. 

Chapter 6 explains how to insert the transportation assets for your 

network of care facilities. Chapter 7 explains how to generate reports and 

interpret them most effectively.  You can also fi nd an at-a-glance set of 

directions for running TML+ at the back of this guide. 

Understanding the Symbols

The  a  symbol indicates an underlying assumption for how TML+ 

operates. 

The ✓ symbol indicates tips for running the program. The information 

following the check mark is a suggestion for how to use TML+ most 

effectively.
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Welcome to TML+ ......................

The Tactical Medical Logistics Planning Tool (TML+) is a software 

program designed for Navy and Marine Corps medical planners 

as:

•  a simulation tool that models the fl ow of patients from the 

point of injury (POI) through more defi nitive care; and 

• a research tool that supports systems analysis, operational 

risk assessment, and fi eld medical services planning. 

TML+ is a joint project between the Naval Health Research 

Center (NHRC) and Teledyne Brown Engineering (TBE). This 

project was sponsored by the Bureau of Medicine and Surgery 

and the Offi ce of Naval Research. 

Background ...........................

The Development of FRSS .................

The Marine Corps Combat Development Command and 

the Marine Corps Systems Command (MARCORSYSCOM) 

developed the Forward Resuscitative Surgery System (FRSS) 

in response to changing warfi ghting doctrine. Marine Corps 

concepts and doctrine state that warfi ghting will require 

increased mobility and dispersion, and refl ect a higher tempo of 

operations among combat elements. These goals require medical 

assets to achieve greater mobility and faster response without 

compromising the high level of care traditionally administered. 

Answering these needs, FRSS is a highly mobile, rapidly 

deployable, trauma surgical unit that provides emergency 

surgical interventions required to stabilize casualties who might 

otherwise die or lose limbs before reaching treatment.  FRSS 

Chapter 
One Introduction



  1-2  
TML+
User’s Guide

may be used as the initial surgical capability ashore in the traditional 

amphibious assault, or it may be the only surgical capability ashore, as 

in an Operational Maneuver From the Sea scenario. FRSS is designed to 

respond to the demands of rapid phase changes that require the ability 

to shift operational objectives quickly and effi ciently. To meet this mission, 

FRSS requires a small logistical footprint that supports early introduction 

into the operating area, rapid movement, deployment, and re-deployment 

in forward areas. 

Introducing this new capability into the Marine Corps continuum of 

care has raised many questions as to its impact on medical treatment 

and resources. Therefore, MARCORSYSCOM sponsored an effort to 

represent the medical assets required to support FRSS in all stages of 

operations. Assisting in this effort, NHRC developed TML+ as a tool to 

research how FRSS could most effi ciently use medical resources such as 

supplies, personnel, and transportation, to provide patients with the best 

protection and medical care possible.  

Role of NHRC in Medical Modeling  ............

NHRC was chosen to develop TML+ because of its expertise in Marine 

Corps medical assets. The Modeling and Simulation Department at NHRC 

has been at the forefront of developing casualty rates and streamlining 

Marine Corps medical resources for several years. Three primary NHRC 

initiatives are the development of casualty rates, the supply review 

process, and the development of the Estimating Supplies Program (ESP).

Development of Casualty Rates 

TML+ incorporates NHRC’s projection rates for wounded in action (WIA), 

nonbattle injuries (NBI), and diseases (DIS). 

Three separate methods were used to calculate the casualty rates: 

• WIA rates are based on the percentages of various injury types and 
the anatomical locations of those injuries during previous combat 
operations.  

• NBI rates are also based on observed injury types and anatomical 
locations, but were adjusted for environmentally dependent injuries 
like heat or cold injuries.  



TML+ 
User’s Guide

  1-3

• DIS rates are based on fi rst mapping diseases into patient condition 
(PC) clusters, estimating the percentage for each PC code within 
that cluster, and adjusting for regional differences and changes in 
incidence distributions occurring during the operations.

NHRC adjusted the data for factors such as recency and type of 

operation, number and type of troops, and medical advances, and 

computed the rates for intensity levels light, moderate, heavy, and intense.  

Supply Review Process

NHRC’s second initiative is the supply review process. In the early 

1990s, NHRC developed this systematic process to review medical 

supplies at far-forward areas of care. NHRC started with the PCs 

developed by the Joint Readiness Clinical Advisory Board (JRCAB) and 

then (1) identifi ed the medical tasks required to treat each PC, and (2) 

determined the supplies and equipment required by each medical task. 

This supply review model included only those items with an identifi ed 

clinical requirement in the supply stream, thereby eliminating the weight, 

cube, and cost of extraneous items. This process achieved substantial 

reductions (approximately 30%) in the number of items, weight, and cube. 

Development of ESP

NHRC used the data gathered from the supply review process to develop 

a third initiative, ESP. ESP is a software program for medical planners, 

providers, and trainers that calculates the supplies needed to treat an 

expected patient stream. ESP contains treatment briefs for over 400 

PCs treated at far-forward areas of care. Using the data from the NHRC 

review process, each medical task in ESP is linked to the specifi c materiel 

needed to perform that task. The user inputs the number and types of 

patients and selects the functional areas expected to provide treatment; 

ESP then estimates the items and quantities required to treat those 

patients.

NHRC, through a partnership with TBE, has incorporated ESP’s data 

into TML+. In addition, we expanded TML+ capabilities to include the 

additional data required to stochastically model casualty fl ow through a 

network of treatment facilities. 
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TML+ Capabilities .......................

TML+ includes the following underlying data:

• PCs, tasks, supplies

• Task sequences 

• Treatment times

• Weight, cube, and cost of supplies

• Died of Wounds due to time (DOW)

• Died of Wounds due to complications (DOC)

• Type, speed, and capacity of transportation assets

• Levels of care and their respective functional areas

• Number of personnel

• Personnel skills sets

TML+ uses stochastic processes to model patient treatment and 

outcomes. TML+:

• generates the PCs for a patient stream in an identifi ed theater.  

• prioritizes the treatment and evacuation of patients based on the 
severity of injuries.

• models mortality as killed in action, died of wounds due to 
complications, and died of wounds due to a delay in treatment.

• simulates patient fl ow through a network of treatment facilities, 
including arrival times, wait times, and treatment times. 

• provides the ability to customize a treatment facility with user-defi ned 
medical capability and personnel assets.

• models the routing and utilization of transportation assets.

• generates dynamic reports in graph and tabular formats that show 
status of the treatment facilities, patient disposition, and resource 
utilization.

Assumptions ..............................

You can obtain a list of the assumptions of TML+ through the Reports 

Navigator. See page 7-3 to learn how to select a report. 
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Future Work ..............................

NHRC is currently working to expand the functionality of TML+ by 

expanding the customization of levels of care, including data for 

equipment simulation-based acquisition, incorporating geographic 

information system (GIS) mapping features, and providing smart 

reporting.

Customizing Medical Capability

TML+ currently offers you the ability to customize medical capability 

of a treatment facility by allowing you to modify the number and type 

of personnel as well as the quantity of supply items in the inventory. In 

future versions, TML+ will modularize medical capability by grouping 

medical tasks into capabilities-based sets. For example, the resuscitation 

module would include all those tasks necessary to resuscitate a patient 

at a specifi c functional area. You will be able to customize the medical 

capability of a facility by identifying its modular medical capabilities as 

well as the quantity and types of supplies and personnel required to 

perform those capabilities.  

Equipment Simulation-Based Acquisition

NHRC is working to incorporate information useful for equipment 

simulation-based acquisition. Such data will include when each 

equipment item needs maintenance or repair and how many times it can 

be used before it needs to be replaced. This information will be useful in 

determining the quantity of equipment items for a scenario as well as how 

the operational capability of these items affect the treatment of the patient 

stream.

GIS Mapping System 

NHRC is working to incorporate GIS mapping system into TML+. This 

feature will allow you to choose any location in the world on which to lay 

down your level of care (LOC) treatment network. In addition, the GIS 

mapping system will automatically calculate the distances between the 

treatment facilities.



  1-6  
TML+
User’s Guide

Smart Reporting 

TML+ will include smart reporting features that compare reports from 

different runs of a scenario. As you make changes and rerun the 

simulation, you will be able to compare the same reports across runs to 

learn how your changes affected specifi c metrics in your scenario. 

In addition, TML+ smart reports will have dashboard indicators (such as 

red, yellow, and green lights) that signal the availability of resources at 

treatment facilities. These indicators will give you a quick, top-level view 

of when and where defi ciencies occur within the current setup of the 

treatment network.

Uses for TML .............................

TML+ can help you identify the best course of action for the anticipated 

patient stream with the projected assets. You can use TML+ to determine: 

• whether a particular treatment facility can successfully handle a 
specifi c patient stream.  

• how changing the distances among treatment facilities with different 
capabilities affects patient treatment.

• which and how much of the supply, personnel, and transportation 
assets are utilized by the expected patient stream.

• whether one treatment network (type, location, and number of 
assets) is more effi cient for treating patients than another. 

TML+ is a versatile tool that allows you to perform different types of 

planning:

• Deliberate planning: use TML+ before deployment to determine the 
medical assets and the treatment network that would optimally treat 
the expected patient stream.  

• Crisis-action planning: use TML+ during deployment to reconfi gure 
the treatment network in response to contingency events.

• Near real-time planning: use TML+ to track how patient treatment 
and evacuation events proceed as the mission is performed.
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Program Overview .........................

TML+ basically works like this:

1. Open TML+.

2. Select a defi ned scenario or create a new scenario.

3.  Enter the time periods of your scenario in hours or days.

4.  Enter the number of WIA, DIS, and NBI for each time period.

5. Identify the number of POIs, the types and number of LOCs, 
the distance between the LOCs, and the types and number of 
transportation assets.

6.  Modify, if you desire, the types and number of personnel at 
each level of care, the capabilities of a specifi c level of care or 
functional area, and the speeds and capacities of transportation 
assets.   

7.  Run reports on casualty generation, care providing, and 
transportation.

TML+ traces how patients proceed through the treatment network 

by calculating where patients are treated, how long patients wait for 

treatment, and how long evacuation takes with the identifi ed assets.

Customer Support .........................

If you have questions about TML+, check our Web site at 

www.nhrc.navy.mil/programs/tml. In addition, feel free to email us at 

tml@nhrc.navy.mil 
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Getting Started
Chapter 

Two

Installing TML+ ......................

System Requirements

Before you install TML+, check to see that your system meets the 

following requirements:

• Pentium® III class processor

• Microsoft Windows® 2000, Windows XP

• 128 MB of RAM recommended

• Microsoft Internet Explorer 6.0 or higher

TML+ requires the installation of the two fi les listed below.  You 

must download and install these fi les before running TML+.

1. Microsoft .NET Framework Version 1.1 Redistributable 
Package 

2. Microsoft Data Access Components (MDAC) 2.8  

Installing the Program

To install TML+ from a CD:

1. Close all applications.

2. Insert the CD into the CD-ROM drive.

3.  Double-click the My Computer icon located on your 
desktop.

4.  Double-click the CD-ROM drive icon.

6.  Double-click the TML.exe icon and follow the dialog boxes.

1

2

3

4

5
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Downloading TML+ .........................

TML+ is available for download to those who have a .mil address. 

To download TML+:

1. Type the following address into your browser and press Enter:     
www.nhrc.navy.mil/programs/tml

2. Click the Download button and then click the Register button. 

3.  Type the registration information into the form and click Submit 
Registration.

4.  Click the TML+ icon.

5. In the Save As dialog box, select the C:\ drive from the drop-down 
menu and click Save.

6.  Close all applications.

To install TML+, use Windows Explorer to navigate to where you just 

saved the program. Double-click the TML+ icon and follow the dialog 

boxes.

1

2

3

6

4

5

5
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Starting TML+ ............................

To start TML+:

1. Click    in the lower left-hand corner of your screen.

2. Open the Programs folder, then the TML+ folder.

3.  Click the TML+ icon to open the program. 

Turn to Chapter 3 to learn how to select an existing scenario or create a 

new scenario.

Quitting TML+ ............................

To quit TML+:

1. Click the File menu.

2. Click Exit.

1

2

1

2

1

2

3
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Parts of the TML+ Screen .................

The Scenario Explorer 
shows the different 
parts of the scenario 
you select.  

The Common Data 
Explorer shows 
the predefi ned 
types of LOCs and 
transportation 
assets in TML+. 
You drag and drop 
these icons onto 
the Network View 
to add them to your 
scenario. 

The Properties box shows the  
information associated with the 
item you select in the Scenario 
Explorer, Common Data Explorer, 
or Network View. You enter 
the majority of the scenario 
information here. 

The Network View displays a 
graphic view of the inputs 
you select for your scenario. 
You connect treatment 
facilities in this window. 

Toolbars provide 
shortcuts for basic 
functions, such as 
saving, deleting, and 
zooming.  

The Menu bar provides 
primary TML+ functions, 
such as inserting 
casualty generators, 
running the scenario, 
and opening the reports.    
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Customizing the Interface ................

Closing Windows

To close the Scenario Explorer, Common Data Explorer, Properties box, 

or Network View, click the X in the upper right-hand corner of the window 

you want to close.  

Reopening Windows

To reopen the Scenario Explorer, Common Data Explorer, Properties box,  

or Network View, go to the View menu and select the window to reopen.

Moving Windows

To move the Scenario Explorer, Common Data Explorer, and Properties 

box around the screen:

1.  Place the cursor over the title of the window (i.e., the words 
“Scenario Explorer,” “Common Data Explorer,” or “Properties”).

2.  Hold down the mouse, drag the box to the desired location, then 
release the mouse.

Click here 
to close

Click here 
to reopen

1

2
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Commands in the Menu Bar .................

Seven menus are located on the menu bar at the top of the screen: File, 

Edit, View, Insert, Simulation, Window, and Help.

File

Use the File menu to create a new scenario, open an existing or recently 

used scenario, save a scenario, print the screen, and exit the program.

Edit

Use the Edit menu to cut, copy, and paste text into the fi elds in the 

Properties box, and to delete items in the Network View.

View

Use the View menu to open the Scenario Explorer, Common Data 

Explorer, Network View, recent reports, Properties box, and the overview 

screen of the Network View. 

Insert

Use the Insert menu to insert casualty generators and comments on the 

Network View.

Simulation

Use the Simulation menu to run the scenario.

Window

Use the Window menu to perform commands that organize the open 

windows. The Cascade command tiles all the open Network Views 

diagonally. The Tile Horizontally command places the open Network Views 

one above the other, while the Tile Vertically command places them side 

by side. You can also use the Window menu to close all open documents 

or toggle between more than one open document. 

Help

Use the Help menu to obtain instructions on how to operate TML+ and 

for background information. For more information on getting help, turn to 

page 2-8.
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Using the Toolbars .......................

TML+ has four toolbars visible on the screen: standard, execute, zoom, 

and format. 

Standard

Use the Standard toolbar to create a new scenario, open an existing 

scenario, save a scenario, cut, copy, and paste text and objects, and 

delete objects.

Execute

Use the Execute toolbar to run the open scenario.

Zoom

Use the Zoom toolbar to zoom in, zoom out, return the Network View to 

normal, and fi t the Network View to the screen.

Format

Use the Format toolbar to align the objects in the Network View.

Customizing Your Toolbars

Each toolbar can be undocked, moved, or closed. In addition, you can 

add to or remove buttons on the toolbar.

To undock (or redock) it, double-click any gray part of the toolbar. To close 

it, click the X in the upper right-hand corner of the toolbar. To reopen a 

toolbar, right click in the gray area at the top of the screen and select the 

toolbar to open. To move a toolbar, place the cursor on any gray part and 

drag the toolbar to the desired location.

To add or remove buttons:

1.  Click the little black arrow in the lower right corner of the toolbar. 

2.  Move the cursor to Add or Remove buttons and then over the 
name of the toolbar you wish to change. 

3.  Select the button to add or remove. If the button is checked, 
selecting it removes it from the toolbar. If the button is not 
checked, selecting it adds it to the toolbar.

1

2

3
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Inserting a Comment ......................

You can insert a comment box in the Network View. Comment boxes are 

useful for keeping pertinent notes or information you want visible while 

you build the scenario. 

To insert a comment box:

1.  Go to the Insert menu and select Comment.

2.  Click on the yellow box and type in your comment.

Getting Help .............................

You can get help through ToolTips and through TML+ Help fi les.

ToolTips

ToolTips are fl ags of information that appear when your mouse passes 

over certain items. Place your mouse near the item in question to view the 

ToolTip. Keep the mouse still until the fl ag pops up.

Sample
ToolTip

1

2

2

1
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Contents and Index Help

Contents and Index Help are available through an on-line help window. 

Contents Help is organized by subject. Index Help shows an alphabetical 

listing of terms and functions. 

To use Contents Help:

1. Press F1 on your keyboard or click the Help menu and select 
Help Contents.

2. Click a folder icon to display a list of topics on a subject. Click a 
topic to display the information.

To use Index Help:

1. Press F1 on your keyboard or click the Help menu and select 
Index.

2. Click an item to display the information.

To search for a topic:

1. Press F1 on your keyboard or click the Help menu and select 
Search.

2. Type in the text to search for and click OK.

Click here for 
Contents Help

Click here for 
Index Help

Click here to 
search

1

2

1

2

1

2
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Five TML+ Confi gurations ..............

TML+ comes with fi ve canned confi gurations of treatment 

facilities. You must choose one to start TML+. You can modify your 

initial confi guration once the program is open. For descriptions of 

each level of care, turn to page 5-1.

The fi ve confi gurations are:

• First Responder (1RSP) to Battalion Aid Station (BAS) to 
Casualty Receiving and Treatment Ship (CRTS)

• 1RSP to BAS to Surgical Company (SC) to CRTS

• 1RSP to BAS to FRSS to CRTS

• 1RSP to BAS/Shock Trauma Platoon (STP) to CRTS

• 1RSP to STP/FRSS to CRTS

Each confi guration has the following default settings:

• 10 WIAs stochastically generated per 24 hours

• 72 hours in length

• Northeast Asia (NEA) theater

Selecting a Scenario
Chapter 

Three
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Creating a New Scenario ..................

To select a new scenario: 

1. Start TML+ (see page 2-3). The TML+ Start Page dialog box 
opens. 

2. Click the New button. A dialog box opens.

3. Double-click the icon corresponding to the confi guration of your 
choice. Remember to name your new scenario (see page 3-4). 

Selecting an Existing Scenario ...........

To select an existing scenario: 

1. Start TML+ (see page 2-3). The TML+ Start Page dialog box 
opens. 

2. To choose an existing scenario, fi rst click the Browse button, 
then double-click the scenario of your choice. (Note that recently 
viewed scenarios are displayed in the Start Page box.)

3
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1
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scenarios
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Entering Scenario Properties.............

The Properties box has TML+ generated and user-defi ned (optional and 

required) fi elds that describe your scenario.   

TML+ Generated Fields

The automated fi elds are Creation Date, Full Path, and Modifi cation Date. 

The creation date is the date you created the scenario. The full path 

shows where the fi le is stored. The modifi cation date is the date you last 

modifi ed the scenario. 

User-Defi ned Optional Descriptive Fields

The optional fi elds are Author, Email Address, Organization, Phone #, 

Classifi cation, Description, and Version. 

To enter descriptive information on your scenario:

1. Click the scenario icon—the fi rst icon in the Scenario Explorer.

2. In the Properties box, click in the right column of the desired fi eld. 
For example, to add your name as the Author, click Author.

3.  If a cursor becomes visible, type in the information. If an arrow 
becomes visible, click the arrow to view a drop-down menu and 
click the item of your choice.  

User-Defi ned Required Fields

The required fi elds are Scenario Name, Length of Scenario, Units, 

Reports Filename, Output Detailed Audit, Overwrite, Deterministic, 

Number of Replications, Random Number Seed, and Theater. Instructions 

for these fi elds are covered in the following sections. 

3
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Entering the Name of the Scenario ........

To enter the name of the scenario:

1.  Click the scenario icon—the fi rst icon in the Scenario Explorer.

2.  In the Properties box, click in the right column of the fi eld marked 
Scenario Name. Type in the name of your choice.

1

2
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Entering the Length of the Scenario ......

To enter the length of the scenario:

1.  Click the scenario icon—the fi rst icon in the Scenario Explorer.

2.  In the Properties box, click in the right column of the fi eld marked 
Length of Scenario. Type in the number of hours or days for your 
scenario.

3. Click in the right column of the fi eld marked Units. Click the arrow 
that appears to view the drop-down menu. Select hours or days.

1

2

3
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Renaming the Reports Database File .......

When TML+ runs a scenario, it generates a reports database fi le named 

“TML reports” by default. You have the option to rename this fi le.

To rename the reports database fi lename:

1.  Click the scenario icon—the fi rst icon in the Scenario Explorer.

2.  In the Properties box, click in the right column of the fi eld marked 
Filename. Type in the desired name of the fi le. 

1

2
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Overwriting the Reports Database File ....

The overwrite command allows you to overwrite the reports database fi le 

each time you run the same scenario. By default, the overwrite command 

is set to No, which means that each time you run TML+ it overwrites the 

information from the previous run.  

To overwrite the reports database fi le:

1.  Click the scenario icon—the fi rst icon in the Scenario Explorer.

2.  In the Properties box, click in the right column of the fi eld marked 
Overwrite under the Reports heading. 

3.  Click the black arrow and select Yes to overwrite the database fi le. 
Select No.

1

2

3

1
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Turning Off the Detailed Audit  Report.... 

By default, TML+ generates a detailed audit report that lists each 

operation executed by TML+. This is a very lengthy report used for 

debugging purposes.  To have TML+ create the detailed audit fi le: 

1.  Click the scenario icon—the fi rst icon in the Scenario Explorer 
window.

2.  In the Properties box, click in the right column of the fi eld marked 
Output Detailed Audit under the Reports heading. 

3.  Click the black arrow and select No. 

NOTE: Turning off the detailed audit report does not affect the generation 

of other TML+ reports.

Selecting the Type of Simulation .........

TML+ is designed to run stochastically. This process generates more 

realistic output that better refl ects the chance events of a real-life scenario 

when compared with deterministic models. A deterministic feature is built 

into TML+ for debugging purposes only. It is highly recommended that 

you leave the Deterministic fi eld in the Properties box set at False.

1

2

3

3

2



TML+ 
User’s Guide

  3-9

Entering the Number of Replications ......

You can generate multiple runs of a scenario. You can also look at the 

output for each run or an aggregate of the information of all the runs.

To enter the number of replications for your scenario:

1.  Click the scenario icon—the fi rst icon in the Scenario Explorer.

2.  In the Properties box, click in the right column of the fi eld marked 
Number of Replications. Type in the number of times you want 
TML+ to run the scenario.

1

2
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Modifying the Random Seed Number .........

As a stochastic model, TML+ uses random draws to simulate the scenario. 

This process requires a random seed number, the number used to 

initialize the random number generator. A large prime number works best. 

The default random seed number is 13143.

To modify the random seed number for your scenario:

1.  Click the scenario icon—the fi rst icon in the Scenario Explorer 
window.

2.  In the Properties box, click in the right column of the fi eld marked 
Random Seed Number and type in the number of your choice.

1
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Selecting the Theater for the Scenario ...

You can select from three theaters of operations: Southwest Asia (SWA), 

NEA, and Europe. By selecting a theater, you are identifying the PC code 

distribution that TML+ will use to generate the casualty stream.  

To select the theater for the scenario:

1.  Click the scenario icon—the fi rst icon in the Scenario Explorer 
window.

2.  In the Properties box, click in the right column of the fi eld marked 
Theater. 

3. Click the arrow that appears to view the drop-down menu and 
select the theater of your choice.
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Deleting an Item in Your Scenario........

To delete an item:

1.  Click the item in the Scenario Explorer, Common Data Explorer, 
or Network View. If you are deleting an item in the Network View, a 
bright green box around the item indicates it is selected.

2.  Press the Delete key on your keyboard or click the red X on the 
toolbar at the top of the screen.

NOTE: In the Common Data Explorer, you can only delete those items 

that you created. For information on how to create a customized LOC type 

or transportation type, turn to pages 5-12 and 6-8, respectively.
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Saving a Scenario ........................

To save a scenario:

1. Click the File menu located in the top left-hand corner of the 
screen.

2. Select Save. If you are in a new scenario that has not yet been 
saved, a dialog box opens.

3.  Navigate to where you would like to save your scenario. 

4.  Type in the fi le name and click Save.
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Deleting a Scenario ......................

TML+ creates a separate .tml fi le for each scenario. You can delete the 

scenario using Windows Explorer.

To delete a scenario:

1. Open Windows Explorer. 

2. Navigate to the folder that holds the TML scenario you want to 
delete.  

3.  Right-click the scenario icon and click Delete.
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Defi ning Casualty Generators
Chapter 

Four

About Casualty Generation ............

TML+ offers you three ways to generate casualties. You can 

use the repeatable rate, table rate, or user-defi ned rate options 

explained later in this chapter. 

Based on your input (e.g., 10 casualties per 24 hours), TML+ 

stochastically generates the specifi c PC code for each patient.

About PC Codes .......................

TML+ has over 400 PC codes. Each PC code is linked to various 

information.  Each PC code is:

• assigned to one of three types: WIA, DIS, or NBI.  

• assigned to a patient category that describes the kind of 
injury or disease (e.g., head, burns, gastrointestinal). 

• is designated as ambulatory (the patient can walk) or litter 
(the patient cannot walk and requires a litter).

• linked to the medical tasks, supplies, and personnel 
necessary for treatment.

You can view the PCs by following the instructions on the next 

page in the section Viewing Underlying PC Data.
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Viewing Underlying PC Data ...............

To obtain the underlying PC data in TML+:

1.  Click the Common Database icon in the Common Data Explorer.

2.  Click in the fi eld that reads View Details. An ellipsis button 
appears.

3.  Click the ellipsis button.

4.  For a list of PCs, click the tab labeled PCs. For a list of underlying 
PC distributions, click the tab labeled PC distribution. 

5.  Click OK to close.
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KIA are those troops who 
die on the battlefi eld. 
They receive no medical 
treatment.

a

Entering Killed in Action ................

You enter killed in action (KIA) as a ratio. The numerator is the number 

of troops expected to be killed. The denominator is the number of 

troops with WIA injuries. For example, if the KIA ratio is 1 to 100 and 

your scenario has 500 WIAs, approximately 5 troops are stochastically 

generated as KIA.

To enter KIA:

1.  Click the Casualty Generators folder in the Scenario Explorer.

2.  In the Properties box, click in the right column of the fi eld marked 
Number killed in action. Type in the number of troops expected to 
be killed per group of WIAs.

3.  Click in the right column of the fi eld marked Wounded in action. 
Type in the number of WIAs.

1

2
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Wounded in action
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Creating a Casualty Generator by Rate ....

When using a casualty generator by rate, WIA, DIS, and NBI PCs are 

generated by separate casualty generators. For each type of patient 

stream, you must enter at least one casualty generator (e.g., to generate 

WIA, DIS, and NBI patients, enter three casualty generators).   

The rate you enter in this generator is repeated until the end of the 

scenario. For example, if you enter a rate of 10 WIAs every 24 hours for 

a 72-hour scenario, the rate is repeated 3 times and approximately 30 

casualties are stochastically generated. For a 60-hour scenario, the rate 

is repeated 2.5 times, and approximately 25 casualties are stochastically 

generated.

To create a new casualty generator by rate:

1.  In the Insert menu, click Casualty Generator, and click Rate.

2.  In the Properties box, click in the right column of the fi eld marked 
Name. Type in a name for the casualty generator. 

3. Click in the right column of the fi eld marked Mean Number of 
Casualties. Type in the number of casualties. 

4.  Click in the right column of the fi eld marked Time Period. Enter the 
number of hours in which the mean number of casualties occur. 

5. Click in the right column of the fi eld marked Casualty Type. Click 
the arrow that appears. Select the type from the drop-down menu.

The rate option is best 
if you want to generate 
a steady casualty stream 
of one or more type (WIA, 
DIS, NBI) of casualty.

✓
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Creating a Casualty Generator by Table ... 

Casualty generator by table requires you to enter the number and type 

of casualties for one or more time periods. Like the casualty generator by 

rate, each generator generates one type of patient (WIA, DIS, NBI). Enter 

more than one generator to generate more than one type of patient (e.g., 

to generate WIA, DIS, and NBI patients, enter three casualty generators). 

Unlike the rate option, the numbers you enter for each casualty type are 

generated only once. Therefore, you identify a rate for block of time. For 

example, if you enter 10 casualties for 24 hours and 15 for 48 hours, then 

approximately 10 casualties are stochastically generated for the fi rst 24 

hours and 15 casualties for hours 25 through 48.  

To create a new casualty generator by table:

1.  In the Insert menu, point the mouse to Casualty Generator, and 
select Table.

2.  In the Properties box, click in the right column of the fi eld marked 
Name. Type in a name for the casualty generator. 

3. In the Properties box, click the right column of the fi eld marked 
Casualty Type. Click the arrow that appears and select the type 
from the drop-down menu.

4. In the Properties box, click the word Collections and click the 
ellipsis button. A new window opens. 

5. Click in the column marked Mean Number of Casualties. Type in 
the number of casualties expected to occur in the fi rst time block.

6. Click in column marked Ending Time Period (hrs). Type in the hour 
on which you want the rate you entered in step 5 to stop. 

7. Repeat steps 4 and 5 as many times as desired. Click OK.

The table option is best 
if you want to model a 
pulse or pause in the 
casualty stream.
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Creating a User-Defi ned Casualty Generator

The user-defi ned casualty generator allows you to override TML+’s 

stochastic patient stream generation. You enter the arrival time, PC code, 

and POI for each casualty.  

NOTE: The TML+ database is structured according to PC codes. Any 

patient streams you paste into TML+ must use PC codes. 

To create a user-defi ned casualty generator:

1.  Click the Insert menu, point the mouse to Casualty Generator, and 
select User-Defi ned.

2.  In the Properties box, click in the right column of the fi eld marked 
Name. Type in a name for the casualty generator. 

3. In the Properties box, click in the right column of the fi eld marked 
User-Defi ned Table and click the ellipsis button. A new window 
opens. 

4. Click the Casualty Generator button to add a patient.

5. Click in the Arrival Time column and type in the time in hours. Click 
in the Patient Code, Casualty Type, and Point of Injury columns 
and select the desired information from the drop-down menus.  

6. Repeat steps 4 and 5 as many times as desired. Click OK.

The user-defi ned option 
is best if you want to 
use a patient stream from 
another software program.
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Modifying the Casualty Generator Name ....

To modify the name of a casualty generator:

1.  Click the casualty generator icon in the Scenario Explorer.

2. In the Properties box, click in the right column of the fi eld marked 
Name.

3. Type in the name of your choice.
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Modifying the Mean Number of Casualties..

The mean number of casualties is the number of casualties expected to 

occur within a specifi c period of time.  You can modify the mean number of 

casualties for generators by rate and by table. 

Casualty Generator by Rate

To modify the mean number of casualties in a casualty generator by rate:

1.  Click the casualty generator icon in the Scenario Explorer.

2. In the Properties box, click in the right column of the fi eld marked 
Mean Number of Casualties. 

3. Type in the number of your choice.
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Casualty Generator by Table

To modify the number of casualties in a casualty generator by table:

1.  Click the casualty generator icon in the Scenario Explorer.

2. In the Properties box, click the word Collection. An ellipsis 
appears.

3.  Click the ellipsis. The table opens.

4. Click in the column marked Mean Number of Casualties and type 
in the desired number for each time period. 

5. Click OK.
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Modifying the Generator’s Time Period ....

You can modify the time period for casualty generators by rate and table. 

Casualty Generator by Rate

To modify the time period of a casualty generator by rate: 

1.  Click the casualty generator icon in the Scenario Explorer.

2. In the Properties box, click in the right column of the fi eld marked 
Time Period (hrs).

3. Type in the number of hours.
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Casualty Generator by Table

To modify the time period of a casualty generator by table:

1.  Click the casualty generator icon in the Scenario Explorer.

2. In the Properties box, click the word Collection. An ellipsis 
appears.

3.  Click the ellipsis. The table opens.

4. Click in the column marked Ending Time Period and type in the 
hours for each time period. 

5. Click OK.
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Modifying a Generator’s Casualty Type ....

Each casualty generator by rate and by table generates one type of 

patient: WIA, DIS, or NBI.  

To modify the type of casualties assigned by the generator:

1.  Click the casualty generator icon in the Scenario Explorer.

2. In the Properties box, click in the right column of the fi eld marked 
Casualty Type. 

3. Click the arrow that appears to view the drop-down menu and 
select the type.

NOTE: The user-defi ned casualty generator assigns type to each patient. 

To modify the type of patient, click the casualty generator icon in the 

Scenario Explorer and follow steps 5 and 6 on page 4-6. 

1

2

3

32

1



TML+ 
User’s Guide

  5-1

About the Levels of Care ............

You can select various LOCs for your scenario. Below are 

descriptions of LOCs available in TML+. Shipboard levels of care 

and functional areas are under development.

TML+ allows you to customize various aspects of LOCs. Turn 

to page 5-12 for instructions on how to customize a medical 

treatment facility. 

Self/Buddy Aid (SBA)

SBA is the treatment at the POI that each patient gives 

themselves or receives from another troop.

First Responder  (1RSP)

1RSP is the company corpsman who fi rst administers medical 

treatment to a casualty, performing fi rst aid and emergency 

procedures.

Battalion Aid Station (BAS) 

BAS is positioned as close as possible to forward line troops and 

offers clinical assessment. The treatment administered includes 

the use of intravenous fl uids and antibiotics, preservation of the 

airway by surgical procedure, and application of more secure 

splints and/or bandages. BAS provides initial resuscitation and 

routine health services and carries the theater sick-call supplies. 

Supplies are confi gured to provide resupply to line corpsmen.

Shock Trauma Platoon (STP)

STP can serve as a beach evacuation station, reinforce a BAS, 

operate as an intermediary casualty collecting and clearing point 

between forward elements and the surgical company (SC), or 

Inserting Levels of Care
Chapter 

Five
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serve as the forward element of an SC (i.e., triage/evacuation platoon) 

preparing to relocate. STP includes triage and limited operating room 

(OR) and ward capabilities.

Forward Resuscitative Surgery (FRSS)

FRSS can serve as a forward element of the SC or as a stand-alone 

surgical element colocated with a BAS or STP. FRSS provides limited 

triage/preoperative trauma management and postoperative holding capa-

bility, and is equipped to provide life- and limb-saving surgical procedures. 

Includes triage, OR, and ward (with limited holding capability). 

Surgical Company  

SC objectives are to save life and limb, provide initial resuscitative 

treatment, and perform stabilization for evacuation for those casualties 

whose medical requirements exceed SC capabilities. SC has greater 

surgical and medical capabilities than BAS, including triage, OR, ward, 

x-ray, laboratory (lab), pharmacy, dental, and preventive medicine. 

Casualty Receiving & Treatment Ship (CRTS) 

CRTS is a general-purpose amphibious assault ship that receives, 

provides treatment for, and transfers casualties. The objectives of care are 

to save life and limb, provide initial resuscitative treatment, and perform 

stabilization for evacuation for casualties whose medical requirements 

exceed CRTS capabilities. The ship’s capabilities include triage, lab, x-ray, 

OR, ward, pharmacy, dental, battle dressing station, portable medical 

locker, antidote locker, fi rst-aid box, emergency response kit (ERK), junior 

ERK, and preventive medicine capability.

En Route Care System (ERCS)

ERCS has three phases: casualty evacuation (CASEVAC), tactical 

medical evacuation (MEDEVAC), and strategic evacuation.  CASEVAC, 

phase one, renders care during patient transport from the POI to a 

casualty collection point or medical treatment facility, such as STP, FRSS, 

or SC. The casualty may not have received care or may have received 

care from a buddy, a fi eld corpsman, or a medical offi cer at a BAS prior 

to CASEVAC. MEDEVAC, phase two, provides care during evacuation 

from a BAS, STP, FRSS, or SC to a theater hospital. Strategic evacuation, 

phase three, renders care during evacuation from the theater hospital to 

defi nitive care inside or outside the continental United States.  

SC does not currently 
include dental 
capabilities.

a

CRTS is currently 
modeled with the medical 
capabilities, personnel, 
and supplies of an SC.

a

Only consumable supplies 
are calculated for 
MEDEVAC. Personnel 
requirements are not 
simulated.

a
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About the Functional Areas

Below is a description of functional areas within the LOCs. 

Triage/SST  

Triage/SST provides receipt, resuscitation, and sorting of casualties and 

treats casualties with battle injuries, nonbattle injuries (NBIs), and those 

who can return to duty within 72 hours. The triage/SST renders general 

surgical support and preoperative clinical functions. 

Operating Room  

OR provides resuscitative/stabilizing surgery to casualties unlikely to 

survive MEDEVAC. 

Ward  

SC ward provides monitoring and recuperative care to postoperative 

patients and those that can return to duty within 72 hours. FRSS ward 

has limited holding capabilities.

X-ray  

X-ray provides x-ray section and processing capabilities. 

Laboratory  

Lab provides hematology, microbiology, blood chemistry, and urinalysis 

capabilities.

Pharmacy 

Pharmacy provides the materiel required to establish and maintain 

pharmacy capabilities.

Preventive Medicine  

Preventive medicine performs technical functions for ensuring water 

potability, food inspection, sanitary waste disposal, vector control, and 

communicable disease monitoring and immunization. Preventive Medicine 

Maneuver  was developed for the First Responder. For the Surgical 

Company, (1) Preventive Medicine Technician (PMT) for the PMT, PM 

Offi cer, and Environmental Health Offi cer (EHO); (2) Entomologist; and 

(3) Industrial Hygiene (IH) for the IH Offi cer and EHO. 

Only consumable supplies 
are calculated for x-
ray, lab, and pharmacy. 
Tasks performed at these 
areas are not included 
in patient treatment 
time. Also, personnel 
requirements are not 
simulated at these 
functional areas. 

a

Preventive medicine is not 
currently modeled. 

a
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Understanding Patient Treatment...........

TML+ simulates the treatment of patients through your treatment network. 

There are two primary aspects: the treatment itself and queuing. The 

patient arrives at the functional area and queues for treatment. When the 

required assets become available, the patient proceeds into the functional 

area to receive treatment. 

Treatment is the series of medical tasks required to treat a specifi c 

PC. TML+ starts treating a patient when the personnel and equipment 

required to treat the specifi c PC are available.

Queuing occurs before and during treatment. When a patient arrives at 

a functional area, TML+ determines if the personnel and equipment are 

available to perform the fi rst task. If the medical resources are assigned a 

busy status, the patient is placed into a waiting pool. 

When the assets needed to perform the fi rst task are available, the patient 

moves from the waiting pool into the functional area and treatment begins. 

For each task, TML+ performs the same test to determine the availability 

of the required personnel and equipment assets—a patient cannot 

proceed to the next task until the necessary assets are free. If the assets 

are busy, the patient is placed back into the waiting pool. 

For more information on patient treatment and queuing, refer to the TML+ 

Methodology Manual.  

Understanding Service Discipline .........

Service discipline is the method that TML+ uses to queue the patients 

for treatment. In other words, it is the set of rules used to determine who 

enters service fi rst if several casualties are waiting. TML+ offers two types 

of service disciplines. You can choose to treat patients on a fi rst-in-fi rst-out 

(FIFO) basis, which treats the casualty who has been waiting the longest, 

or a Priority basis, where the casualty with the highest severity is selected 

to receive treatment fi rst (see page 5-15). 

If FIFO is selected, patients entering the waiting pool are rank ordered 

based on arrival time. If Priority is selected, patients are rank ordered on 

the severity of the PC and arrival time. 



TML+ 
User’s Guide

  5-5

Inserting a New POI ......................

A POI is a geographical site on the battlefi eld where injury occurs.  

To insert a new POI:

1.  Click and drag the SBA icon in the Common Data Explorer onto 
the Network View.  A POI and SBA appear.

2. Click on the POI icon in the Scenario Explorer.

3.  In the Properties box, click in the right column of the fi eld marked 
Name. Type in a name for the POI. 

4.  In the Properties box, click the right column of the fi eld marked 
Probability for this POI. Type in the percentage (in decimal format) 
of the patient stream you expect to occur at this POI. This number 
must be between 0 and 1. 

NOTE: The probabilities for all POIs must add up to 1. The casualties are 

randomly assigned to the POIs based on these probabilities.

1

2

3

4
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2

TML+ automatically bundles 
a POI with an SBA to 
simulate the care that 
casualties receive far 
forward. The two cannot 
be separated within the 
network. 

a
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Modifying the Name of a POI ..............

To modify the name of a POI:

1.  Click the icon of the POI icon in the Scenario Explorer.

2. In the Properties box, click in the right column of the fi eld marked 
Name.

3. Type in the name of your choice.

1

2

3
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Modifying the Probability for a POI ......

To modify the probability of a POI:

1.  Click the icon of the POI icon in the Scenario Explorer.

2. In the Properties box, click in the right column of the fi eld marked 
Probability for this POI.

3. Type in a number between 0 and 1. The probabilities of all POIs 
must equal 1. 

1

2

3

1

32
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Editing All Probabilities for POIs .......

Once you create POIs, you can edit the probabilities for each in one place. 

To edit the POI probabilities:

1.  Click one of the POI icons in the Scenario Explorer. 

2. In the Properties box, click the words POI Probability Editor. An 
ellipsis appears. 

3. Click the ellipsis button. A table opens in a new window.

4. Enter the probabilities for each POI in the Probability column. 
Each number must be between 0 and 1 and all probabilities must 
add up to 1.

5.  Click OK.

Normalizing POI Probabilities ............

Normalizing POI probabilities makes the probabilities for all POIs sum to 1. To 

normalize POI probabilities, follow steps 1-3 above, click Normalize, then click 

OK.

1

2

3

4

5

The Normalize function is 
useful if you have added 
POIs to an already defi ned 
scenario or if you have a 
large number of POIs.

✓

5

4
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Inserting a Predefi ned LOC ................

TML+ comes with a variety of predefi ned LOCs. These are listed in the 

Common Data Explorer under the Level of Care Types folder. 

To insert a predefi ned LOC:

1.  In the Common Data Explorer, click the plus sign (+) to the left of 
the Level of Care Types folder to see a list of the available LOCs. 

2.  Click and drag the icon of the desired LOC type onto the Network 
View.  TML+ automatically names the LOC. 

3. To change the LOC name, click in the right column of the fi eld 
marked Name in the Properties box. Type in a name for the LOC. 

4. Link this LOC to another by following the instructions on page 5-
11.

1
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Inserting Colocated LOCs ................

When you colocate two levels of care, you are assigning them to the same 

geographic location. The LOCs share the burden of the casualty stream. 

With colocated facilities, one LOC is designated as the primary facility and 

the other as secondary. All casualties go to the primary LOC fi rst. Then, 

based on the PC code, wait time, and provider availability, certain patients 

proceed to the secondary LOC (see the TML+ Methodology Manual for 

more information).  

To insert colocated levels of care:

1.  In the Common Data Explorer, click the plus sign to the left of the 
Colocated Levels of Care Types folder to see a list of the available 
colocated LOCs. 

2.  Click and drag the icon of the desired colocated LOC type onto 
the Network View.  TML+ automatically names the colocated LOC. 

3. To change the colocated LOC name, click in the right column of 
the fi eld marked Name in the Properties box. Type in a name for 
the colocated LOC. 

4. Link this colocated LOC to another by following the instructions on 
page 5-11.
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Linking LOCs .............................

Once you place your LOCs onto the Network View (see page 5-9), you 

link them to show the route you anticipate your patients to travel. When 

you link two LOCs, you are creating a primary route. However, the 

choices you make for your patient evacuation routes are subject to patient 

treatment rules (see page 5-4 for more information).

In some cases, when you link an LOC, TML+ automatically draws a 

secondary route. The secondary route is an alternate route that patients 

travel if the primary route is busy or if the patient has a PC code not 

treated at the next LOC (the primary route). In other words, not all PCs 

are treated at all LOCs. If you delete the route drawn automatically by 

TML+, those patients not treated at the next LOC in your network do 

not receive further treatment.

To link an LOC: 

1.  Place the mouse over the LOC to connect. It changes from an 
arrow to a hand.

2.  Click and drag the mouse to the LOC to which patients can be 
evacuated. 

3. Release the mouse. A line appears linking the two LOCs. TML+ 
enters a default value of 1 km for the distance.

4.  Click the 1 km. A text fi eld appears. Type in the distance between 
the linked LOCs.

1

2

3

4

1

You can only link an LOC 
to either the same LOC 
type (e.g. BAS to BAS) 
or to an LOC with more 
capability (e.g. BAS 
to SC). You cannot send 
casualties forward in the 
evacuation chain.

a

2
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Creating a Customized LOC Type............

A customized LOC type is a copy of an existing LOC type that you change 

to suit your needs. Currently, you can modify the quantity of the personnel, 

the individual equipment and consumable supply items within an AMAL, 

and the service discipline (the method used to queue patients). Future 

versions of TML+ will have expanded capability that include identifying the 

LOC medical capabilities (e.g., holding, resuscitation). 

To create a customized LOC:

1.  In the Common Data Explorer, right-click the LOC type you wish to 
customize. A menu appears.

2. Select Copy.

3.  In the Common Data Explorer, right-click the Level of Care Types 
folder. A menu appears.

4.  Select Paste. An icon appears at the bottom of the LOC types list. 

5. In the Properties box, click in the fi eld labeled Name. Type in a 
name for the new LOC type you created.

Follow the instructions in the next section to modify the LOC’s personnel 

quantities and supply data. To add a customized LOC type to the scenario, 

follow the instructions on page 5-12.
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Modifying Personnel in an LOC Type .......

Each LOC comes with defi ned types and quantities of personnel. 

To modify the personnel of an LOC type:

1.  Create a customized LOC type for the LOC you want to change 
(see page 5-12).

2. In the Common Data Explorer, double-click the customized LOC.

3. Click the functional area to modify.

4. In the Properties box, click View Details. An ellipsis appears.

5. Click the ellipsis button. A new window opens.

6. Click the Personnel tab.

7. Click in the quantity column and enter the new quantities for each 
type of personnel. 

8. Click OK.

To add your customized LOC type to the scenario, follow the instructions 

on page 5-9.
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Modifying Supply Data in an LOC Type .....

Each functional area is associated with equipment and consumable items. 

You can modify the individual quantities of each item.

To modify the supply quantities of an LOC type:

1.  Create a customized LOC of the LOC you want to change (see 
page 5-12).

2. In the Common Data Explorer, double-click the customized LOC 
(by default this is labeled “Copy of [name of LOC type]”). This 
expands the LOC to show its functional areas.

3. Click the functional area to modify.

4. In the Properties box, click View Details. An ellipsis appears.

5. Click the ellipsis button. A new window opens.

6. Click the Inventory tab.

7. Click in the Quantity Issued column and enter the new quantities 
for each supply item. 

8. Click OK.

To add your customized LOC type to the scenario, follow the instructions 

on page 5-9.
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Modifying the Service Discipline .........

The service discipline is the method that TML+ uses to queue the patients 

for treatment. You have two choices: FIFO or Priority.  FIFO treats patients 

on a fi rst in-fi rst out basis, treating the patient who has been waiting the 

longest.  Priority treats the patients based on severity, treating the most 

serious PCs fi rst. Priority is the default setting.

To modify the service discipline for an LOC type:

1.  Create a customized LOC type for the LOC you wish to modify 
(see page 5-12).

2.  In the Common Data Explorer, click the plus sign next to the 
customized LOC you just created. This expands the functional 
area list.

3. Click the functional area you want to change.

4. Click View Details. An ellipsis appears. 

5. Click the ellipsis. A new dialog box opens defaulted to the General 
tab.

6.  Click the down arrow under Service Discipline and select FIFO or 
Priority. 

7. Click OK.
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Modifying the Distance Between LOCs ......

To modify the distances between two LOCs:

1.  In the Network View, click the number displayed between the two 
LOCs. A text fi eld appears.

2. Type in the new distance kilometers.

1

2
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Inserting Transportation Assets
Chapter 

Six

About the Transportation Assets ......

You identify the transportation assets for each LOC that you 

add to your treatment network. Each asset has the following 

characteristics:

• an empty speed: the speed of the vehicle carrying no 
patients. 

• a loaded speed: the speed of the vehicle when loaded with 
at least one patient.

• maximum capacity: the number of ambulatory patients a 
vehicle can carry.  Two ambulatory seats equals one litter 
space.

• patient ambulatory loading and unloading time: the time 
it takes to load or unload a patient who can walk.

• patient litter loading and unloading time: the time it takes 
to load or unload a patient on a litter.

• patient wait time: the amount of time the vehicle remains 
grounded waiting for a full patient load. 

You can modify these characteristics by following the instructions 

on page 6-8. 

Types of Transportation Assets .......

Walk

The walk asset indicates a patient walking or being carried to the 

next LOC. The walk asset is to indicate that a vehicle is not being 

used. This is typically used to model the transportation from the 

POI to the First Responder. 
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Ambulances

You can choose from two types of ambulances: M997 and M1035. The 

M997 has the following default settings: 8 maximum capacity (which 

equals 4 maximum litter carrying capacity), empty and loaded speed of 

88 km/hr, ambulatory patient loading and unloading time of 2 minutes per 

patient, litter patient loading and unloading time of 3 minutes per patient, 

and a wait time of 10 minutes.

The M1035 has the following default settings: 3 maximum capacity (which 

equals 4 maximum litter carrying capacity), empty and loaded speed of 

88 km/hr, ambulatory patient loading and unloading time of 2 minutes per 

patient, litter patient loading and unloading time of 3 minutes per patient, 

and a wait time of 10 minutes.

Helicopters

You can choose from two types of helicopters: CH-46 and CH-53. The 

CH-46 has the following default settings: 15 maximum capacity, empty 

and loaded speed of 268 km/hr, ambulatory patient loading and unloading 

time of 2 minutes per patient, litter patient loading and unloading time of 3 

minutes per patient, and a wait time of 32 minutes.

The CH-53 has the following default settings: 55 maximum capacity, 

empty and loaded speed of 268 km/hr, ambulatory patient loading 

and unloading time of 2 minutes per patient, litter patient loading and 

unloading time of 50 minutes per patient, and a wait time of 32 minutes.

Modifying Assets

You can change the default settings for these assets by creating a 

customized transportation asset (see page 6-8). 

How Assets Are Called ....................

Each asset is assigned to a base LOC. The base is the LOC at which 

the asset is stationed. The asset leaves the base to pick up patients and 

returns to the base to drop the patients off for care. 

All the assets assigned to the same level of care are put into a pool called 

the base pool. The fastest asset in the pool (based on empty speed) is 

drawn when an evacuation call is placed. If two assets have the same 

speed, the asset with the largest capacity is chosen. 

No transportation assets 
are modeled between 
colocated LOCs.

a



TML+ 
User’s Guide

  6-3

Transportation Routing Rules .............

Transportation routes are the paths vehicles travel within the treatment 

network. There are two types of routes: primary and secondary. Both 

types of routes are indicated by solid lines (future version will show 

secondary routes as dotted lines). Each of these types of routes has a set 

of rules that determines the fl ow of patients.   

Primary Routing Rules

Primary routing rules are the TML+ underlying data that defi ne the overall 

fl ow of patients within the treatment network. Although you identify the 

primary LOCs a patient can visit, the fl ow of patients is restricted by these 

rules, which are based on the medical capabilities of the selected LOCs 

as defi ned by Navy and Marine Corps doctrine. 

The primary routing rules in TML+ are:

1.  Patients must move from POI to SBA.

2.  Patients can only move back in the medical evacuation chain, i.e. 
from less capability to more capabilty. 

3.  Patients walk from SBA to next LOC defi ned in the scenario.

4. Transportation assets must be part of the scenario to answer an 
evacuation call.

5. Transportation assets do not stop at more than one LOC in one trip.

6.  Transportation assets do not go between different sites of the same 
LOC type (e.g., BAS1 to BAS2).

Primary routing rules are top-level rules that are always used the same 

way, independent of time and the specifi cs of how the patient stream 

proceeds. For example, whether there are 50 patients in the fi rst 10 

minutes or 3 patients in 3 hours, they will always move from POI to SBA.
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Secondary Routing Rules

Secondary routing rules are those rules that are activated based on the 

individual patient stream and the context of the scenario. As the patient 

stream places demands on resources, secondary routing rules direct the 

patient fl ow based on the availability of assets. The secondary routes are 

determined by three steps. 

First, TML+ checks to determine if the patient’s PC is treated at the next 

LOC. If no, the patient is queued for evacuation for the next available LOC 

that does treat the patient’s PC.  

If the PC is treated at the next LOC, TML+ performs the second step, 

checking if the LOC has a busy status. If the LOC is busy, the patient is 

queued for evacuation. A busy status means the patient capacity of the 

LOC is full and a certain number of patients (as designated by NHRC 

according to doctrine) are waiting. For example, if both beds in FRSS 

pre-op are busy and two patients are waiting, FRSS is designated as busy 

and patients are routed to the next LOC. 

If the LOC is free, TML+ performs the third step. TML+ stochastically 

determines by a random draw whether the patient is treated at that LOC. 

Because not all PCs are treated at every functional area, this random 

draw is based on the percentage of patients with a specifi c PC that are 

treated at a specifi c functional area. 

For example, if a patient with a surgical PC arrives at BAS, the primary 

routing rules determine the patient be evacuated from BAS to FRSS. 

However, if FRSS has a busy status at the time the patient arrives, 

the patient will queue to be evacuated to CRTS. If FRSS is free, TML+ 

executes a random draw to determine if FRSS treats the patient or is 

evacuated to CRTS because only a percentage of those patients with that 

surgical PC are treated at FRSS. 

Contact NHRC at tml@nhrc.navy.mil if you would like more information on 

the capacities or the underlying percentages of treatment for PCs at the 

various functional areas. 
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How Patients Are Queued  for Transport....

Once a patient is determined to be evacuated, TML+ checks the 

availability of transportation assets. The assets are prioritized by empty 

speed and capacity, with the fastest and largest being called fi rst. In 

addition, the asset goes to the LOC with the highest priority casualty 

waiting to be evacuated.

If the asset is available, the patient is assigned a claimed status and the 

capacity of the asset is decremented based on the PC’s designation 

as a litter or ambulatory. When the transportation asset reaches full 

capacity, it is assigned a busy status. This status prevents the asset from 

being called for another evacuation run until its present assignment is 

completed. 
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Inserting a Transportation Asset .........

TML+ comes with a variety of predefi ned transportation types. These are 

listed in the Common Data Explorer under the Transportation Types folder. 

To insert a transportation asset into your scenario:

1.  In the Common Data Explorer, click the plus sign to the left 
of the Transportation Types folder to see a list of the available 
transportation assets. 

2.  Click and drag the icon of the desired transportation asset onto 
the LOC (or its existing transportation pool) in the Network View 
where you want the asset to be based.  TML+ automatically 
names the asset. 

3. To change the Transportation name, click in the right column of the 
fi eld marked Name in the Properties box. Type in a name for the 
asset. 
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Modifying the Transport Name .............

To modify the name of a transportation asset in your scenario:

1. Click the icon of the asset in the Scenario Explorer.

2. In the Properties box, click in the right column of the fi eld marked 
Name.

3.  Type in the name of your choice. 

1
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Creating a Customized Transport ..........

A customized transportation asset is a copy of an existing transportation 

type that you change to suit your needs. Currently, you can change the 

speed, capacity, loading and unloading times for both litter and ambulatory 

patients, and the wait time of the asset. 

To create a customized transportation asset:

1.  In the Common Data Explorer, right-click the icon of the 
transportation asset you wish to customize. A menu appears.

2.  Select Copy.

3.  In the Common Data Explorer, right-click the Transportation Types 
folder. A menu appears.

4.  Select Paste. An icon appears at the bottom of the Transportation 
Types list.

5. Click the new icon.

6.  In the Properties box, click the fi eld labeled Name. Type a name 
for the new transportation asset you created. 

Follow the instructions in the next sections to modify the asset’s 

characteristics. To add your customized asset to the scenario, follow the 

instructions on page 6-6.
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Modifying Speed of a Transport ...........

You can only modify the speed by creating a customized transportation 

asset (see page 6-8). You can change both the speed of the asset when 

empty (no patients) and when loaded (with patients).

To modify the speed:

1.  Create a customized transportation asset (see page 6-8).

2. In the Common Data Explorer, click the icon of the customized 
asset you wish to modify.

3.  In the Properties box, click the right column of the fi eld marked 
Empty. Type in a speed for the asset when it is empty (no 
patients).

4. In the Properties box, click the right column of the fi eld marked 
Loaded. Type in a speed for the asset when it is loaded with 
patients.
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Modifying Capacity of a Transport........

You can only modify the capacity by creating a customized transportation 

asset (see page 6-8). The capacity of a transportation asset is the 

maximum number of ambulatory patients a vehicle can carry. Remember, 

two ambulatory seats equal one litter space.  

To modify the capacity:

1.  Create a customized asset (see page 6-8).

2.  In the Common Data Explorer, click the icon of the customized 
asset you wish to modify.

3.  In the Properties box, click the right column of the fi eld marked 
Capacity. Type in the maximum quantity of ambulatory patients the 
vehicle can carry. (Remember two ambulatory seats equals one 
litter space.)
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Modifying Loading and Unloading Times ....

You can only modify the litter and ambulatory loading/unloading times by 

creating a customized transportation asset (see page 6-8). The loading 

and unloading times indicate the amount of time necessary to load or 

unload each patient.  You can modify the loading and unloading times for 

both ambulatory and litter patients.  

To modify the loading and unloading times:

1.  Create a customized asset (see page 6-8).

2. In the Common Data Explorer, click the icon of the customized 
asset you wish to modify.

3.  In the Properties box, click the right column of the fi eld marked 
Ambulatory Loading Time. Type in the number of minutes it takes 
to load each ambulatory patient. Repeat for Ambulatory Unloading 
Time.

4. In the Properties box, click the right column of the fi eld marked 
Litter Loading Time. Type in the number of minutes it takes to load 
each patient on a litter. Repeat for Litter Unloading Time.
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Modifying Wait Time ......................

You can only modify the wait time by creating a customized transportation 

asset (see page 6-8). The wait time is the number of minutes the asset 

waits for a full patient load before leaving the level of care. Wait time starts 

when the asset fi nishes loading the last patient waiting for transport. If 

another patient arrives, the wait time clock resets.

1.  Create a customized asset (see page 6-8).

2. In the Common Data Explorer, click the icon of the customized 
asset you wish to modify.

3.  In the Properties box, click the right column of the fi eld marked 
Wait Time. Type in the number of minutes the asset will wait for 
patients before leaving the level of care.
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Modifying Distance Traveled by an Asset ..

The distance an asset travels between LOCs is indicated by the number 

above the line connecting two LOCs in the Network View. 

To modify the distance an asset travels between LOCs:

1.  In the Network View, click the number above the line connecting 
the LOCs. 

2.  Type in the number of km.
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Generating and Using Reports
Chapter 

Seven

About TML+ Reports ...................

There are four groups of TML+ reports: casualty estimation, care 

providing, transportation, and general information.

The casualty estimation reports pertain to the number and types 

of casualties that occur in the scenario.

The care providing reports pertain to the treatment that occurs 

within the LOCs and functional areas, such as how many patients 

are treated, how long treatment takes, and how long patients wait 

to receive treatment.

The transportation reports pertain to patient evacuation, such as 

how many patients are evacuated per trip, how long patients have 

to wait for evacuation, and how many times each asset is used.

The general information reports provide a summary of your 

scenario inputs.

You can also access a list of the assumptions built into TML+. 

About the Reports Navigator .........

When you run your scenario, TML+ generates an extensive 

output database. The Reports Navigator is the dynamic interface 

that you use to access this database fi le. The Report Navigator 

is equipped with drop-down menus that give you control in both 

what data you see and how they are displayed. 

Turn to page 8-1 for an explanation of each report and why it is 

useful. 
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Understanding the Drop-Down Menus ........

The Reports Navigator comes with drop-down menus that let you control  

what data you see and how they are displayed.

Replication Menu

If you run more than one replication of a scenario, the Replication menu 

lets you select the data for an individual replication or for all replications. 

When you select All from the drop-down menu, you see the mean, the 

standard deviation, the minimum, and the maximum for each data fi eld. 

Group Menu

The Group menu lets you select the primary area of data you are 

interested in. You can select casualty estimation, care providing, 

transportation, or general information (see page 7-1 for a general 

description of each report group).

Subgroup Menu

The Subgroup menu lets you select the specifi c report you want to see. 

The choices in this menu change depending upon which Group you 

select. In other words, the options in the Subgroup menu are different for 

the Care Providing group than for the Transportation group. Chapter 8 

provides a description of each report (each group/subgroup combination). 

Report Type Menu

The Report Type menu lets you select the format of the data. The options 

in this menu change according to the selections in the Group and 

Subgroup menus.  Various reports can be displayed in table, pie chart, 

step chart, and/or Gantt chart formats.

LOC and FA Menus

The LOC and functional area menus appear when appropriate, depending 

upon the choices you make in the Group and Subgroup menus. You 

use these menus to view the data pertaining to the different LOCs and 

functional areas in your scenario. 
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Generating Reports .......................

Once you have built your scenario, you run the simulation to generate the 

reports. The reports open in the Report Navigator, a new window that sits 

atop the Network View. 

To generate the reports on your scenario:

1. Click the  button in the toolbar at the top of the screen. 

2.  Follow the instructions in the following sections to use Reports 
Navigator.

WARNING:  If you have a complex scenario, the reports may take 

substantial time to generate. One way to speed up the run time is to turn 

off the audit report (see page 3-8).

Selecting a Report .......................

To select a report:

1.  Click the Replication menu and select the desired replication.

2.  Click the Group menu and select the area of data. 

3.  Click the Subgroup menu and select the specifi c report.

4.  Click the Report Type menu and select how you would like the 
data to be displayed.

5.  If present, click the LOC and/or FA menu and select the facility.

Turn to page 8-1 for a description of each report and why it is useful.
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Modifying the Replication ................

If you run more than one replication of a scenario, the Replication menu 

lets you select the data for an individual replication or for all replications. 

When you select All from the drop-down menu, you see the mean, the 

standard deviation, the minimum, and the maximum for each data fi eld. 

 To modify the replication you are viewing:

1.  Click the Replication menu.

2.  Select the replication you wish to view.

Modifying the Group ......................

The Group menu lets you select the primary area of data you are 

interested in. You can select casualty estimation, care providing, 

transportation, or general information (see page 7-1 for a general 

description of each report group).

To modify the group of data you are viewing:

1.  Click the Group menu.

2.  Select the area of data you wish to view.

1

2

1

2

2

2

1

1



TML+ 
User’s Guide

  7-5

Modifying the Subgroup ...................

The Subgroup menu lets you select the specifi c report you want to see. 

The choices in this menu change depending upon which Group you 

select. In other words, the options in the Subgroup menu are different for 

the Care Providing group than for the Transportation group. Chapter 8 

provides a description of each report (each group/subgroup combination). 

To modify the subgroup you are viewing:

1.  Click the Subgroup menu.

2.  Select the specifi c report you wish to view.

Modifying the Report Type ................

The Report Type menu lets you select the format of the data. The options 

in this menu change according to the selections in the Group and 

Subgroup menus.  Various reports can be displayed in table, pie chart, 

step chart, and/or Gantt chart formats.

To modify the subgroup you are viewing:

1.  Click the Subgroup menu.

2.  Select the specifi c report you wish to view.
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Modifying the LOC or FA ..................

The LOC and FA menus appear when appropriate, depending upon the 

choices you make in the Group and Subgroup menus. You use these 

menus to view the data pertaining to the different LOCs and functional 

areas in your scenario. 

To modify the LOC or FA you are viewing:

1.  Click the LOC or FA menu.

2.  Select the LOC or FA you wish to view.

Sorting Your Reports .....................

You can sort your reports by each individual column (i.e., one column at 

a time). To sort by more than one fi eld, follow the instructions in the next 

section on fi ltering. 

To sort by a column in the report:

• Click the heading once for ascending order. 

• Click the heading twice for descending order.

1

2

Click on the 
heading to sort.

2

1
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Filtering Your Reports ...................

When you fi lter a report, you are selecting to display a subset of the 

data in a report. Filtering is different from sorting because it hides the 

information you do not want to focus on. Filtering is also different from 

sorting because you can fi lter more than one column at a time. 

The fi ltering function is located at the top of each column as denoted by 

the  button. 

NOTE: Once you select a fi lter, the fi lter icon turns blue  so that you 

can identify which columns have fi lters.

Using Standard Filtering Options

You can fi lter all columns on blanks, nonblanks, and any entry in the 

column. If you fi lter on blanks, only those rows with empty fi elds in the 

column on which you fi ltered are displayed. If you fi lter on nonblanks, only 

those rows with an entry (text or numeric) in the column on which you 

fi ltered are displayed. 

In addition, you can fi lter the column on any entry in that column. For 

example, say you have the following entries in a column: 3, 4, 8, 8, 8. If 

you want to see only the data with a value of 8, you can select 8 from the 

fi lter and view only the three records with a value of 8 in that column.  

To fi lter your report:

1.  Click the  button.

2.  Select the object to fi lter on.

3.  Repeat steps 1 and 2 for all the columns you want to fi lter.

1

2

3

1
2

1
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Customizing Your Filter

If you do not want to use the standard fi ltering choices (blanks, nonblanks, 

and entries in the column), you can customize your fi lter. The customizing 

feature allows you to fi lter on one or more conditions rather than one 

specifi c entry. For example, say you have the following entries in a column: 

3, 4, 5, 5, 8. You can use the customization feature to display only those 

columns with a quantity greater than 4.

To customize your fi lter:

1.  Click the  button.

2.  Select Custom. A new dialog box opens.

3.  Click the drop-down menu and select the Operator.

4.  Click the drop-down menu and select the Operand.

5.  To add another condition, click the Add a condition button and 
follow steps 3 and 4.

6.  Click OK.

1

2

3

4

5

6

6

5
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Clearing a Filter

To clear the fi ltering options on a column:

1.  Click the  button.

2.  Select All.

3. Repeat for each column you wish to clear.

 

Printing a Report ........................

To print your report:

1.  Click the  button on the toolbar. 

2.  Select the printer from the drop-down menu.

3.  Select the number of copies.

4.  Click OK.

1

2

3

4

1

2

3

2

4

3

2
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Exporting a Report .......................

You have the option to export your data to a comma separated fi le (.csv), 

which can be opened in Excel. 

To export the selected report:

1.  Click the  button on the toolbar. A dialog box opens.

2.  Navigate to where you would like to save the fi le. Make a note of 
this location.

3.  Type in a name for your fi le.

4.  Click Save.

1

2

3

4

43
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Report Formats What it says Why it is useful

General Information

Scenario properties Table Shows all the user inputs for the 
scenario. 

Quick at-a-glance of the scenario

Audit report Table Displays each process completed by 
TML+ (a very extensive report).

Used by NHRC for testing purposes

All assumptions Table Lists all the underlying assumptions for 
TML+. 

Casualty Generation

Patients by type Table, pie chart Shows the numbers of WIA, KIA, NBI, 
and DIS.

Provides visibility of the distribution of the types of 
casualties in the patient stream. 

Patients by disposition Table, pie chart Shows the total numbers of died of 
wounds (DOW), died of complications 
(DOC), returned to duty (RTD), still 
in system, and evacuated across all 
LOCs.

Provides visibility of the distribution of patient dispositions 
across the treatment network. Can be used to determine 
if the treatment network is treating patients quickly and 
effi ciently (as indicated by the died of complications and still 
in system statistics). This report can be used in conjunction 
with the Patients by disposition at each LOC report to 
pinpoint specifi cally which LOCs are problematic.

Patients by patient 
condition category

Table, pie chart Shows the numbers of patients with 
each type of JRCAB patient condition 
category (e.g., head, gastrointestinal, 
respiratory).

Provides visibility on the distribution of the types of 
diseases and injuries generated within a certain theater. 
Can be used to determine the particular personnel skills 
required for a scenario.

Patients by disposition 
at each LOC

Table, pie chart Shows the numbers of DOW, DOC, 
RTD, still in system, and evacuated.

Provides visibility of the distribution of patient dispositions 
at the LOC. Can be used to determine if a LOC is treating 
patients quickly and effi ciently (as indicated by the died of 
complications and still in system statistics).

Assumptions Table Lists all the underlying assumptions for 
the Casualty Generation reports.

TML+ Reports Guide
Chapter 
Eight
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Report Formats What it says Why it is useful

Care Providing

Casualty time in sys-
tem by LOC 

Table Shows patient information, such as 
how many arrive at and exit the LOC, 
average wait time for a task and for 
evacuation, total treatment time at the 
selected LOC.

Can be used to determine if enough personnel are present 
to provide treatment at the selected LOC. Can be used in 
conjunction with the Casualty time in system by functional 
area report to determine which functional areas within the 
LOC are problematic.

Casualty time in sys-
tem by functional area

Table Shows patient information, such as 
how many arrive at and exit the LOC, 
average wait time for a task and for 
evacuation, total treatment time, at the 
selected functional area.

Can be used to determine if enough personnel are present 
to provide treatment at the selected functional area.

Casualty accumulation 
by LOC 

Step chart Shows the number of casualties either 
receiving or waiting for treatment at a 
particular time at the selected LOC.

Provides visibility on when congestion occurs within the 
LOC. Can be used to determine how to relieve congestion 
with additional personnel or transportation assets. Can 
be used in conjunction with the Casualty accumulation by 
functional area report to determine which functional areas 
within the LOC are problematic.

Casualty accumulation 
by functional area

Step chart Shows the number of casualties either 
receiving or waiting for treatment 
at a particular time at the selected 
functional area.

Provides visibility on when congestion occurs within the 
functional area. Can be used to determine how to relieve 
congestion with additional personnel or transportation 
assets.

Casualty fl ow Table Shows the fi nal disposition, arrival 
time, treatment time, and time since 
wounding for each casualty at each 
LOC in the system.

Provides visibility on how long each patient is in treatment. 
Can be used to determine if casualties are being treated 
effi ciently through the treatment network. Can be used in 
conjunction with the Casualty fl ow by LOC to determine 
which LOC is problematic.

Casualty fl ow by LOC Table Shows the fi nal disposition, arrival 
time, treatment time, and time since 
wounding for each casualty for the 
selected LOC.

Provides visibility on how long each patient is in treatment. 
Can be used to determine if casualties are being treated 
effi ciently at the selected LOC.
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Report Formats What it says Why it is useful

Care Providing (cont.)

Consumable usage by 
functional area

Table Shows the starting/ending quantities, 
the quantity used, the time the quantity 
was exhausted (if applicable), and 
the casualty being treated when the 
consumables were exhausted at the 
selected functional area.

Can be used to determine which consumables are in high 
demand and which are oversupplied or undersupplied. 

Equipment utilization 
by functional area

Table, Gantt 
chart

Shows the percentage of time of the 
scenario that each equipment item was 
used at the selected functional area.

A high-level report that can be used to determine whether 
certain equipment assets are underused and therefore if 
the number of assets designated for the scenario should 
be reduced. This report is best used as a decision tool only 
if the utilization percentages are very low. This is because 
although an equipment asset may be used a percentage of 
the total scenario time, the time it is used could be due to 
a spike in casualties during which more equipment assets 
were needed to address the needs of the patients.  

Personnel utilization by 
functional area

Table, Gantt 
chart

Shows the percent of time of the 
scenario that each staff person was 
used at the selected functional area.

A high-level report that can be used to determine whether 
certain personnel are under used and therefore if the 
number of assets designated for the scenario should be 
reduced. This report is best used as a decision tool only 
if the utilization percentages are very low. This is because 
although each staff person may be used a percent of the 
total scenario time, the time each person is used could be 
due to a spike in casualties during which more staff were 
needed to address the needs of the patients.  

Tasks performed by 
functional area

Table Shows for each casualty the individual 
tasks performed, the supplies used 
by that task, the time the casualty 
arrived at the task, the time the task 
was started, and the time the task was 
fi nished at the selected functional area

Can be used to determine the skill set required to 
successfully treat the patient stream and to determine 
whether the personnel assets meet the requirements of the 
scenario.

Assumptions Table Lists all the underlying assumptions for 
the Care Providing reports.
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Report Formats What it says Why it is useful

Transportation

Transportation usage 
by pool

Table Shows the number of trips made by 
all the assets, the average number of 
casualties per trip, the percentage of 
trips without any delay, average delay 
for those trips with a delay, the total 
trip time for all assets at the selected 
functional area. 

Can be used to determine if enough transportation assets 
are available to handle the evacuation needs of the 
scenario by looking at the delay in evacuating patients 
across all transportation assets.

Transportation details 
by LOC

Table Shows for each individual 
transportation asset the time 
requested, the casualty IDs for those 
on the asset, the time the asset left 
its home base, the time it arrived and 
departed from the LOC, the time it 
arrived at the home base, and the time 
the unloading of patients was complete 
at the selected LOC. 

Can be used to determine if enough transportation assets 
are available to handle the evacuation needs of the 
scenario by looking at the delay in evacuating patients for 
each asset. In addition, it can be used to determine which 
assets are carrying the majority of the evacuation load and 
whether these assets can be more effi ciently distributed to 
the LOCs in the treatment network.

Transportation 
utilization

Table, Gantt 
chart

Shows for each individual 
transportation asset the percentage 
of time of the scenario that asset was 
used across all LOCs.

Can be used to determine whether certain transportation 
assets are under used and therefore if the number of 
assets designated for the scenario should be reduced. This 
report is best used as a decision tool only if the utilization 
percentages are very low. This is because although a 
transportation asset may be used a percentage of the total 
scenario time, the time it is used could be due to a spike 
in casualties during which more assets were needed to 
address the needs of the patients. 

 
Assumptions Table Lists all the underlying assumptions for 

the Transportation reports.



Start TML+.

1. Click    in the lower 

left corner of your screen.

2. Pass your mouse over 

Programs, then TML+, then 

click the TML+ icon.

Select a confi guration.

1. In the TML+ Start Page 

dialog box, click New. 

2. Double-click the icon with 

the desired confi guration. 

Enter scenario length.

1.  In the Scenario Explorer, 

click the scenario icon.

2.  In the Properties box, type 

in hours or days in the 

Length of Scenario fi eld. 

3. In the Properties box, click 

the arrow in the Units fi eld 

to select hours or days.

Select theater.

1.  In the Scenario Explorer, 

click the scenario icon.

2.  In the Properties box, click 

in the arrow in the Theater 

fi eld and select the theater.

Enter killed in action.

1.  In the Scenario Explorer, 

click the Casualty 

Generators folder.

2.  In the Properties box, type 

in a number in the Number 

killed in action fi eld. 

3.  In the Properties box, type 

a number in the Number of 

troops fi eld. 

1 2 3 4 5

TML+ 
At-A-Glance

1

2

1

2

1

2

1

2

3

1

2

3

2

1

2
3

1

2

1

2
3



Add casualty generators.

1.  Under Insert, click Casualty 

Generator, then Rate.

2. In the Properties box, type 

in the Mean Number of 

Casualties and Time Period.  

3.3. In the Properties box, click 

the down arrow in the 

Casualty Type fi eld and 

select type.

Add LOCs.

1.  In the Common Data 

Explorer, double-click the 

Level of Care Types folder. 

2.  Click and drag the icon 

of the desired LOC type  

onto the Network View and 

release the mouse.   

Connect LOCs. 

1.  Place the mouse over the 

LOC to connect. It changes 

from an arrow to a hand.

2.  Click and drag the mouse to 

the LOC to which patients 

can be evacuated and 

release the mouse.

3. Click the 1 km. Type in the 

distance. 

Add transportation.

1.  In the Common Data 

Explorer, double-click the 

Transportation Types folder. 

2.  Click and drag the icon of 

the desired transportation 

asset onto the LOC in the 

Network View and release 

the mouse.

Run the scenario.

1.  Click the  button 

in the toolbar to run the 

scenario. 

2. Use the drop-down menus 

in the Report screen to 

view different outputs.
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assumptions, 1-4, 8-1
Audit report, 8-1
Author fi eld, 3-3
background, 1-1–1-3
Battalion Aid Station, 5-1
capacity, 6-1, 6-10
Care Providing reports, 8-2–8-3
Casualty Generation reports, 8-1
casualty generator

naming, 4-7
rate, 4-4
table, 4-5
user-defi ned, 4-6

casualty rates, 1-2
Casualty Receiving and Treatment Ships (CRTS), 5-2
casualty stream

mean number for, 4-8
reports on, 8-1, 8-2
selecting theater for, 3-11

CH 53, 6-2
CH-46, 6-2
Classifi cation fi eld, 3-3
colocated levels of care, 5-10
comma separated fi le, 7-10
comment function, 2-8
Common Data Explorer

closing/opening, 2-5
description of, 2-4

creating
casualty generators, 4-4–4-6
customized levels of care, 5-12
customized transportation assets, 6-8

Creation Date fi eld, 3-3
customizing

interface, 2-5
levels of care, 1-5, 5-12
report fi lters, 7-8
toolbars, 2-7
transportation assets, 6-8

deleting
items in scenario, 3-12
scenario, 3-14

Description fi eld, 3-3
detailed audit report, 3-8
Deterministic fi eld, 3-8

diseases (DIS)
developing rates for, 1-2
relation to PC codes, 4-1

distance, 5-11, 5-16, 6-13
downloading, 2-2
Edit menu, 2-6
Email Address fi eld, 3-3
En Route Care System (ERCS), 5-2
entering

length of scenario, 3-5
levels of care, 5-10
mean number of casualties, 4-8
name of scenario, 3-4
number of replications, 3-9
points of injury, 5-5
random seed number, 3-10
theater of operations, 3-11
transportation assets, 6-6

equipment simulation-based acquisition, 1-5
Estimating Supplies Program (ESP), 1-3
exporting, 7-10
File menu, 2-6
fi lters

clearing, 7-9
customizing, 7-8
standard options, 7-7

First Responder, 5-1
Forward Resuscitative Surgery System (FRSS), 

1-1, 5-2
Full Path fi eld, 3-3
GIS mapping system, 1-5
Group menu, 7-2, 7-4
help

contents, 2-9
index, 2-9
menu, 2-6
ToolTips, 2-8

Insert menu, 2-6
inserting

casualty generators, 4-4–4-6
colocated levels of care, 5-10
comment, 2-8
levels of care, 5-9
points of injury, 5-5
transportation assets, 6-6

installing, 2-1
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killed in action (KIA), 4-3
laboratory, 5-3
Length of Scenario fi eld, 3-5
levels of care

colocated, 5-10
customizing, 5-12
distance between, 5-16
inserting, 5-9
linking, 5-11
modifying supply data of, 5-14

litter, 6-10, 6-11
loading times, 6-1, 6-11
M1035, 6-2
M997, 6-2
medical treatment facilities. See levels of care
menu

bar, 2-4, 2-6
for reports, 7-2

Microsoft .NET Framework, 2-1
Microsoft Data Access Components, 2-1
Modifi cation Date fi eld, 3-3
modifying

capacity of transportation assets, 6-10
distance between levels of care, 5-16
distance traveled by transportation, 6-13
loading/unloading times, 6-11
mean number of casualties, 4-8
name of casualty generator, 4-7
name of transportation asset, 6-7
personnel in levels of care, 5-13
points of injury probabilities, 5-7
reports selection, 7-4–7-6
service discipline, 5-15
speed of transportation asset, 6-9
supply data, 5-14
time period, 4-10
type of a generator, 4-12
wait time for transportation assets, 6-12

naming
casualty generator, 4-7
points of injury, 5-6
Reports Database File, 3-6
scenario, 3-4
transportation assets, 6-7

Network View
closing/opening, 2-5
description of, 2-4

nonbattle injuries (NBI)
developing rates for, 1-2
relation to PC codes, 4-1

normalize command, 5-8
operating room, 5-3
Organization fi eld, 3-3
overwrite command, 3-7
patient conditions (PCs), 4-2

description of types, 4-1
role in supply review process, 1-3

patient stream. See casuatly stream
personnel, 5-13
pharmacy, 5-3
Phone # fi eld, 3-3
point of injury

editing probabilities, 5-8
inserting, 5-5
modifying probabilities of, 5-7
naming, 5-6
normalizing probabilities for, 5-8

preventive medicine, 5-3
primary routes, 5-11, 6-3
printing, 7-9
probabilities (POI)

modifying, 5-7
normalizing, 5-8

Properties box
closing/opening, 2-5
description of, 2-4
TML+ generated fi elds, 3-3
user-defi ned fi elds, 3-3

queuing, 5-4, 6-5
quitting, 2-3
random seed number, 3-10
rate (casualty generator), 4-4
Replication menu, 7-2
replications, 3-9, 7-4
Report Type menu, 7-2, 7-5
reports

care providing, 8-2–8-3
casualty generation reports, 8-1
description of report areas, 7-1
detailed audit, 3-8
drop-down menus, 7-2
exporting, 7-10
fi ltering, 7-7
general information reports, 8-1
guide to, 8-1–8-4
modifying selection of, 7-4–7-6
navigator, 7-1
printing, 7-9
selecting, 7-3
sorting, 7-6
transportation reports, 8-4
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Reports Database File, 3-6, 3-7
routing

linking levels of care, 5-11
tranportation assets, 6-3

saving, 3-13
scenario

canned confi gurations, 3-1
creating, 3-2
default settings, 3-1
deleting, 3-14
entering length of, 3-5
naming, 3-4
properties of, 3-3
reports database fi le, 3-6
saving, 3-13
selecting an existing, 3-2

Scenario Explorer
closing, 2-5
description of, 2-4

Scenario Name fi eld, 3-4
secondary routes, 5-11, 6-4
selecting

reports, 7-3
simulation type, 3-8
theater, 3-11

self/buddy aid, 5-1
service discipline

description of, 5-4
modifying, 5-15

Shock Trauma Platoon, 5-1
Simulation menu, 2-6
smart reporting, 1-6
sorting, 7-6
speed, 6-1, 6-9
starting, 2-3
Subgroup menu, 7-2, 7-5
supply review process, 1-3
Surgical Company, 5-2
system requirements, 2-1
table (casualty generator), 4-5
theaters of operations, 3-11
time

casualty generator, 4-10
loading/unloading, 6-11
scenario length, 3-5
wait, 6-12

toolbars
customizing, 2-7
description of, 2-4

transportation assets
customizing, 6-8
description of, 6-1
inserting, 6-6
modifying capacity of, 6-10
modifying distance traveled by, 6-13
modifying loading/unloading times, 6-11
modifying speed, 6-9
modifying wait time, 6-12
naming, 6-7
patient queuing for, 6-5
primary routing rules for, 6-3
reports on, 8-4
secondary routing rules of, 6-4

treatment facilities. See levels of care
triage/SST, 5-3
undocking toolbars, 2-7
Units fi eld, 3-5
unloading times, 6-1, 6-11
user-defi ned casualty generators, 4-6
Version fi eld, 3-3
View menu, 2-6
wait time, 6-1, 6-12
walk asset, 6-1
ward, 5-3
web site

.NET Framework Version 1.1, 2-1
Data Access Components 2.8, 2-1
TML+, 2-2

Window menu, 2-6
wounded in action (WIA)

developing rates for, 1-2
relation to PC codes, 4-1

x-ray, 5-3
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